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RESUMO

Este artigo apresenta uma proposta para o desenvolvimento
unificado de objetos de aprendizagem para acesso via TV digital,
Web e dispositivos mdveis, além de um conjunto de metadados
que permite a catalogagfio e recuperagdo dos mesmos por essas
plataformas. Inicialmente sdo descritos os formatos e linguagens
comuns nos dispositivos das trés plataformas, bem como os
principais padrdes de metadados existentes para as mesmas. Com
base nesse estudo, apresenta-se uma proposta de formatos e
linguagens de programacdo interoperdveis e uma proposta de
metadados. A proposta apresentada foi validada e & parte
integrante do padrdo nacional OBAA [1], que busca a
interoperabilidade através de técnicas de sistemas multiagentes.

ABSTRACT

This paper presents a proposal for unified development of

learning objects, for access by digital TV, Web and mobile
phones, yonder a metadata extension that allow cataloguing and
recovery them by the same platforms. First, the common formats
and programming languages available are described, such as the
main metadata standards for each platform. As result, several
recommendations for interoperability are presented. This
proposal was validated and is part of OBAA brazilian standard
[1], that researches interoperability using multiagent systems.
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1. INTRODUCAO

O mundo, cada vez mais interconectado, proporciona a populagdo
0 acesso a servicos digitais através de diversos mecanismos, como
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Web, TV digital e aparelhos modveis. Dessa forma,
independentemente de onde o wusudrio se encontre, tem
possibilidade de acesso a tecnologia digital.

O objetivo deste artigo € apresentar uma proposta de
desenvolvimento interoperdvel', onde se produz o conteido uma
unica vez e ele pode ser executado nas trés plataformas, evitando
a redundancia na geracdo de conteido. Assim, o foco € na
adaptacdo entre as diferentes plataformas ao invés da criagdo e
manutencio de conteddo de forma exclusiva para cada uma.

Em relagdo aos metadados, o objetivo é disponibilizar um
conjunto de informagdes sobre os objetos de aprendizagem que
permita utilizd-los também de forma unificada nas trés
plataformas. A dificuldade € que os padroes de metadados
educacionais utilizados atualmente foram propostos inicialmente
para a Web, sem prever o acesso de um mesmo objeto de
aprendizagem por diferentes plataformas ou em diferentes
formatos. Além disso, os padroes de metadados utilizados para a
Web ndo sdo os mesmos utilizados para a TV digital.

Este artigo propde conjuntos de metadados de extensdo que, além
de contemplar os requisitos educacionais, atendem também aos
requisitos técnicos de cada plataforma e possibilitam a
catalogacdo dos objetos de aprendizagem para acesso pelas trés
plataformas, tanto para objetos desenvolvidos seguindo as
recomendagdes de interoperabilidade quanto para os que ndo
seguem essas recomendacoes.

A sec¢do 2 apresenta trabalhos relacionados. Na secdo 3, sdo
descritas as recomendagdes para interoperabilidade entre os
padrdes de midia de cada dispositivo. A secdo 4 apresenta os
principais padrdes de metadados existentes para Web e TV
digital, enquanto que a se¢@o 5 descreve as propostas de extensdo
para os padrdes educacionais. Para validar o sistema, a se¢do 6
demonstra trés aplicativos interoperdveis desenvolvidos e seus
metadados associados. Por fim, a se¢io 7 traz as consideragdes
finais.

2. TRABALHOS RELACIONADOS

Na drea de interoperabilidade, a preocupacdo de construcdo de
uma plataforma comum para acesso a informac¢do por meio de

diversos equipamentos ndo ¢ um objetivo recente. Dentre os
trabalhos da W3C, hoje a organizacdo mais respeitada em termos

! Este artigo define interoperabilidade como a capacidade da
utilizacdo de uma linguagem, padrdo ou protocolo comum,
independente do dispositivo, de forma que um conteido possa
ser utilizado em diferentes ambientes.



de padronizacdo para a Web, estd a meta “Interoperabilidade da
Web”, que busca compatibilidade no acesso & Web por todos os
dispositivos [2]. A iniciativa da Web Mével do W3C tem como
meta tornar o acesso a Web, a partir de qualquer tipo de
equipamento, tao simples, facil e conveniente quanto o acesso a
partir de uma mesa de trabalho. Dessa forma, telefones celulares,
smartphones, assistentes pessoais digitais, sistemas de televisdo
interativos, sistemas de resposta por voz, quiosques e até mesmo
alguns eletrodomésticos podem acessar a Internet [2].

O presente artigo segue as recomendagdes de protocolos
recomendados pela W3C para Web e mdveis, mas vai além,
analisando também o ambiente de TV digital e propondo formatos
interoperdveis de midia.

O foco de diversos trabalhos de pesquisa atualmente estd
relacionado a interoperabilidade entre celulares e televisao digital.
E o caso do trabalho de Paulson [3], que faz uma andlise das
possibilidades de banda e tipos de padrdes existentes para assistir
TV nos dispositivos méveis. Cagenius [4] propde uma abordagem
onde o usudrio transfere a visualizagdo da TV digital para o
celular, podendo também interagir através do dispositivo modvel.
O trabalho de Liang [5] apresenta a padronizacdo para cendrios
futuros envolvendo o padrio DVB-S, integrando TV digital,
dispositivos modveis e Internet banda larga. O artigo aborda
algumas necessidades de rede, como o uso de QoS e a
padronizacdo dos canais de retorno via satélite.

Os artigos relacionados vistos acima trabalham com a
possibilidade do usudrio assistir televisdo no dispositivo mével, e
nio na padronizacdo da geracdo do contetdo, buscando uma
interoperabilidade e otimiza¢do nos recursos, como € o caso da
proposta deste artigo.

Em relacdo a trabalhos relacionados a especificacdo de um padrdo
unificado de metadados, a maioria dos projetos e sistemas que
utilizam padrdes complexos formados por vdrios sub-padrdes,
como 0 MPEG-21, utilizam apenas uma parte desses padroes. Até
mesmo padrdes mais simples como o LOM (que serd detalhado
mais adiante) possuem diversos perfis onde cada perfil foi criado
para atender a necessidades de um conjunto especifico de
aplicacdes. CanCore [6] € um perfil LOM para atender aos
requisitos canadenses, enquanto que o UK LOM Core é um perfil
para o Reino Unido [7]. Um ponto importante dos perfis é que os
metadados que estdo de acordo com um perfil também estdo de
acordo com o padrdo do qual o perfil foi originado, uma vez que
sdo sub-conjuntos do mesmo.

Em outros casos um unico padrdo nio atende as necessidades de
uma aplica¢do, por isso sdo feitas extensdes e integragdes de
padrdes. Esta integracdo ainda € uma drea de pesquisa em aberto,
porém algumas abordagens ja foram propostas e implementadas.

Pfeiffer [8] integrou em uma arquitetura os padroes TV-Anytime e
MPEG-7. Nesta arquitetura o padrdao de metadados principal é o
TV-Anytime, porém quando hd a necessidade de descrever
algumas caracteristicas de um contetido dudio-visual, tal descri¢do
¢ realizada utilizando o padrdo MPEG-7. Portanto Pfeiffer definiu
diretrizes e pontos onde deve-se usar o TV-Anytime ou o MPEG-
7. Como alguns dados do MPEG-7 também aparecem no TV-
Anytime, a definicdo de diretrizes implicitamente definiu perfis
dos dois padrdes que sdo combinadas de forma complementar.
Dessa maneira sdo evitadas replicacdes de dados.
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Durand [9] no projeto IST SAVANT (Synchronised and Scalable
AV content Across NeTworks) teve como meta empregar
simultaneamente broadcast e redes de telecomunicag¢do de forma
a possibilitar o uso da TV interativa através de aparelhos estaticos
(televisdo), portéteis (TabletPc) e méveis (PDA). Para isto foi
explorada a integracdo do MPEG-7, MPEG-21 e TV-Anytime. O
TV-Anytime foi utilizado como framework para, semanticamente,
descrever servicos de TV digital, o MPEG-7 foi usado para
descrever formatos de midia e o MPEG-21 foi aplicado na
definicdo de formas alternativas para exibi¢do de contetido nas
diferentes plataformas (aparelhos estdticos, portateis e moveis).

Este artigo reutiliza a idéia proposta no projeto SAVANT, porém
expande o mesmo contemplando também a plataforma Web e
outros dispositivos moéveis. Além disso, os metadados de
adaptacdo do projeto SAVANT sdo combinados com o padrio
MPEG-7, enquanto neste artigo os autores customizaram os
mesmos para aderir ao padrio LOM, que € a base dos padrdes
educacionais existentes.

Em trabalhos efetuados pelos proprios autores, Roesler [10]
apresenta a arquitetura geral para possibilitar a criacdo,
gerenciamento e entrega de contetido para diferentes plataformas.
Bordignon [11] apresenta uma proposta inicial de recomendagdes
de usabilidade e de formatos de midias de uso comum nas trés
plataformas, baseadas em acesso Web. Varella [12] apresenta o
Jframework Web denominado Interop, uma biblioteca de rags para
customizagdo de contetido baseada na tecnologia Java Server
Faces (JSF), para ser utilizada em servidores Web baseados em
JavaEE (Java Platform, Enterprise Edition).

Este artigo aprofunda o estudo realizado em [11] e utiliza o
Jframework Interop proposto em [12] para adaptacdo de paginas
Web dos objetos desenvolvidos. Adicionalmente descreve a
implementagdo do mddulo “Armazenamento” da arquitetura
apresentada em [10], através de uma proposta concreta de
metadados.

3. DESENVOLVIMENTO
INTEROPERAVEL

Em termos de padronizagio, os autores trabalharam com o ISDB-
Tb (International System for Digital Broadcasting — Terrestrial —
brazilian flavour) para TV digital. No ambiente de dispositivos
moveis, utilizou-se a plataforma de celulares, devido a grande
utilizacdo em relacdo aos demais equipamentos moéveis. Em
relagdo aos computadores pessoais, nenhuma restricio foi
aplicada, pois seu poder de processamento e flexibilidade é muito
maior que o dos outros dispositivos. Entretanto, os resultados
podem facilmente ser transportados para outros padrdes
existentes.

As préximas subsecdes apresentam os padrdes de diferentes
aspectos de cada ambiente e apresenta as recomendagdes dos
autores para os diversos niveis de padroniza¢do necessdrios para a
interoperabilidade entre as trés plataformas.

3.1 Interface com o usuario

Interfaces para dispositivos Web, méveis e de TV digital possuem
diferentes recomendacdes de usabilidade, que refletem na
construcdo da interface. Enquanto na Web e no celular, sdo
sugeridas cores claras de fundo e cores escuras de fonte, na TV
digital o inverso é recomendado (cor escura de fundo e cor de



fonte clara). Em relagdo ao padrdo de fonte em si, cada browser
de celular vem com sua prépria definicdo de fontes. Para a TV
digital sao recomendadas Gill Sans, Tiresias e Frutiger, por ser
fontes ndo serifadas e, portanto, mais legiveis [13]. J4 na Web,
vérias fontes podem ser utilizadas. Em relagdo ao tamanho da
fonte, na TV digital sdo sugeridos no minimo 18 pontos para
conteddo texto [13], devido a resolucdo, e no celular 12 pixels
devido ao tamanho de tela. Para a Web, no entanto, ndao foram
encontradas recomendacdes nesse sentido. A Tabela 1 sumariza as
principais recomendacdes de usabilidade.

Tabela 1. Principais recomendacoes de usabilidade.

Dispositivo Web TV Digital Moveis
Cor da Fonte Cores escuras Cores claras Mesmo da Web
Cor do Fundo Cores claras Cores escuras Mesmo da Web

Fonte Arial, Times, Gill Sans, Familia Sans-
recomendada Verdana, Tiresias e serif
Georgia, outras Frutiger
Tamanho de - Titulo: 36 pt Titulo 1: 18 px
Fonte Menus: 20 pt Titulo 2: 16 px
Texto: 22 pt Texto: 12 px
Botoes: 18 pt

3.2 Conteudo Texto

Entre os contetidos de tipo texto, a proposta deste artigo é a
utilizagio da linguagem XHTML?, juntamente com folhas de
estilos CSS® e linguagens Script, conforme detalhamento a seguir:

e Extensible Markup Language (XHTML) é uma linguagem de
marcacdo que tem a mesma abrangéncia de expressdo do
HTML, mas segue as leis da sintaxe XML (Extensible
Markup Language). Além de ndo consumir muito espago, o
XHTML ¢ padronizado para a Web, TV digital e dispositivos
moveis. Na TV digital, o XHTML ¢ inclusive recomendado
para interoperabilidade com os principais sistemas de TV
digital existentes no mundo [14]. Além disso, com
navegadores disponibilizados nos set-top boxes, os objetos
de aprendizagem desenvolvidos poderdo ser acessados sem
novas modificagoes.

e Cascading Style Sheets (CSS): é bastante recomendado para
resolver o problema da personalizacdo da interface em cada
ambiente, conforme descrito na secio 3.1. Dessa forma, o
servidor de aplicagdo retorna um arquivo de estilo diferente
dependendo do dispositivo que estd requisitando a pagina
web. O web designer define um arquivo de estilos para cada
dispositivo somente uma vez e reutiliza o mesmo em todas as
paginas posteriormente criadas. A identificacdo do tipo de
dispositivo e da adaptacdo da folha de estilos € realizada pelo
Jframework Interop, descrito nos trabalhos relacionados.

e Script Languages: tanto XHTML como CSS representam
conteddos estaticos, limitando a possibilidade de criacio de
l6gica dindmica, matemadtica e procedural no lado do cliente.
Para superar essas limita¢cdes das linguagens de marcacio
usam-se linguagens de script. O padrdo ECMAScript foi
gerado a partir da harmonizagdo de tecnologias, onde estio
principalmente o JavaScript (Netscape) e o JScript
(Microsoft). O ECMAScript estende as funcionalidades do
XHTML na Web, celulares e TV digital, porém, com

% http://www.w3.org/TR/xhtml1/
3 http://www.ietf.org/rfc/rfc2318.txt
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diferentes versdes. Na Web, o padrio mais comum é o
ECMA-262 , enquanto que dispositivos moveis e TV digital
suportam subconjuntos desse padrao. Nos dispositivos
moveis, 0 ECMAScript — Mobile Profile (ESMP) foi criado
para dar melhor suporte & comunica¢io em baixas larguras de
banda e clientes com poucos recursos. Nesse ambiente,
sugere-se 0 uso de ESMP junto com o perfil de XHTML
para celular, conhecido como XHTML-MP. Na TV digital,
sua presenga nos set-top boxes é opcional, mas pode ser
utilizada a linguagem Lua Script em seu lugar.

3.3 Imagens

Quanto as imagens, para a TV digital os formatos PNG, JPEG e
H.264/MPEG-4 AVC “I-Picture” sdo de suporte obrigatério em
todos os receptores [14]. Nos dispositivos modveis, os formatos
GIF, JPEG e PNG sdo suportados pela grande maioria dos
dispositivos moéveis atuais, conforme pode ser observado nas
configuracdes dos celulares no site de seus fabricantes.
Adicionalmente, o uso dos formatos GIF 89a e JPEG em
conteddos para Web mével é uma recomendacdo W3C [15].

Com base nisso, para interoperabilidade de imagens, recomenda-
se a utilizacdo do formato JPEG, por ser padrio nos trés
ambientes. O formato PNG também pode ser utilizado. Embora
nido padronizado para dispositivos mdéveis, € amplamente
suportado nos dispositivos existentes no mercado, e é padrdo para
TV e Web.

3.4 Video

O padrio de compressdo de video definido para o sistema ISDB-
Tb foi o H.264/AVC [14]. Nos dispositivos moveis, o formato
3GP com codificagdo H.263 é o mais utilizado e, por isso,
recomendado pelos autores deste artigo. O padrdo de video mp4 é
um codec de video opcional em vdrios padrdes recentes, no
entanto, ¢ amplamente suportado nos mais recentes dispositivos
moveis disponiveis no mercado, juntamente com o H.263.

Na validag@o efetuada neste artigo, os videos foram armazenados
em H.264 e para execugdo no celular foram convertidos para o
formato 3gp com compressdo H.263, uma vez que ndo existe um
formato de video comum para as trés midias.

3.5 Audio

Em relacéio ao dudio, as normas ISDB-Tb definem como suporte
obrigatério o formato MPEG-4 Audio AAC-LC, e como
opcionais os formatos MPEG-2 Audio AAC LC/BC, PCM (AIFF-
C), MPEG-1 4udio layer 3 (MP3) [14]. Para dispositivos moveis,
sdo frequientemente utilizados diversos codecs de dudio, como
AMR-NB, AMR-WB, RealAudio Voice, RealAudio 7, 8 e 10,
MP3, AAC (MPEG-4 Advanced Audio Coding), AAC+ e eAAC+.

Por ser comum aos trés ambientes, os autores recomendam a
utilizacdo do formato de dudio AAC.

4. PADROES DE METADADOS

Dentre os padrdes basicos de metadados para Web e educacionais,
figuram como mais conhecidos o Dublin Core Metadata Initiative
(DCMTI*) e o IEEE 1484.12.1 Standard for Learning Object
Metadata [16], também conhecido simplesmente como IEEE
LOM.

* http://dublincore.org



Definido na RFC 5013 [17], o Dublin Core é um padriao de
metadados que se divide em duas classes de termos que sdo os
elementos (nomes) e os qualificadores (adjetivos), especificando
15 elementos para descricao de recursos. Seu nome deriva de um
workshop efetuado em Dublin, em 1995, onde se reuniram
bibliotecdrios, pesquisadores de bibliotecas digitais, especialistas
em conteudo e linguagens Web. Eles definiram conjuntamente um
nicleo de 15 metadados julgados imprescindiveis para os
recursos. Sao eles: Title, Creator, Subject, Description, Publisher,
Contributor, Date, Type, Format, Identifier, Source, Language,
Relation, Coverage e Rights.

Na educacdo, o mais conhecido ¢ o IEEE LOM, que é também
utilizado como base para outros padrdes mais abrangentes, como
o IMS [18] e SCORM [19] e alguns sub-perfis (application
profiles), que definem como obrigatérios apenas um subconjunto
de metadados, como o CanCore [6] e 0 UK LOM Core [7]. O
IEEE LOM ¢ um padriao de metadados especificado pelo IEEE
Learning Technology Standards Committee (LTSC), visando
definir um conjunto minimo necessdrio de atributos para o correto
gerenciamento, localizagdo e avaliagdo de objetos de
aprendizagem. Prevé metadados para as diferentes categorias,
disponibilizadas em grupos, a saber: General, Life Cycle, Meta-
Metadata, Technical, Educational, Rights, Relation, Annotation e
Classification.

O SCORM (Sharable Content Object Reference Model) define
sistemas de geréncia de aprendizado (LMS - Learning
Management Systems) e contetido educacional de forma que eles
interoperem entre diferentes sistemas que suportam o padrdo.
Basicamente, trata de dois grandes elementos: empacotamento de
conteddo e troca de dados em tempo de execucdo. O primeiro
trata da forma que o contetido deve ser entregue no sentido fisico,
contendo no seu ntcleo um documento chamado imsmanifest, que
contém toda informagdo necessdria para o LMS importar e lancar
o conteuido sem intervencdo humana. O segundo trata da troca de
dados, especificando como o conteido interage com o LMS em
tempo de execucdo. Para descricdo dos metadados do objeto de
aprendizagem, utiliza o padrao IEEE LOM, citado anteriormente.

Na TV digital e conteddo multimidia, outros padrdes de
metadados sdo utilizados, como as tabelas SI/PSI [20], MPEG-7
[21], MPEG-21 [22] e TV-Anytime [23]. As tabelas SI/PSI sdo os
metadados basicos adotados pelos diversos padrdes de TV digital
em opera¢do no mundo. Porém, ndo € objetivo das tabelas SI/PSI
catalogar midias, mas sim permitir ao terminal sintonizar os
diferentes canais e fornecer ao usudrio informacdes sobre a
programacao corrente e futura (Electronic Program Guide).

Os padrdes MPEG-7 e MPEG-21 s@o voltados a conteido dudio-
visual. O MPEG-7, formalmente chamado de Multimedia Content
Description Interface, ¢ um padrdo ISO/IEC desenvolvido pelo
Moving Picture Experts Group (MPEG), no ano de 2001. O
objetivo do MPEG-7 ¢ fornecer uma descri¢@o de contetido dudio-
visual, garantindo a interoperabilidade entre aplicativos
multimidia em busca, indexacdo, filtragem e acesso de contetido
[21]. Isso possibilita que aplicativos diversos possam trabalhar
com metadados multimidia. O diferencial desse padrdo,
comparando-se a outros, ¢ a flexibilidade em relagdo ao que pode
ser descrito, permitindo tanto a descrigdo de informacdes
semanticas e complexas, como estruturas mais simples. O formato
MPEG-21, da ISO/IEC, define um padrdo onde os diferentes
elementos formam uma infra-estrutura permitindo que a entrega e
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consumo de contetidos de midia trabalhem em conjunto. Além
disso, busca diminuir a distribui¢do ilegal de arquivos entre
usudrios na Web. O MPEG-21 ¢é formado por 17 partes,
combinadas em quatro grupos. O primeiro grupo constitui a parte
do framework dedicada a identificacdo, representagdo e controle
de propriedade intelectual dos itens digitais. O segundo grupo
constitui a parte preocupada com as questdes de processamento e
manipulacio dos itens digitais. O terceiro grupo constitui a parte
do framework voltada aos testes e valida¢des da conformidade dos
itens digitais com as especifica¢des criadas pelo primeiro grupo.
Por fim, o quarto grupo constitui a parte envolvida com a
distribui¢do e persisténcia dos itens digitais.

O TV-Anytime € uma associa¢do de organizacdes formada em
uma reunido realizada em Newport Beach, Califérnia, EUA, no
ano de 1999, visto a necessidade de acolher os diversos € novos
servicos que o atual mercado tecnoldgico exige, como
consumidores mais autdnomos e no controle de captar, armazenar,
verificar e distribuir contetido para suas proprias redes pessoais e
outros ambientes digitais, além do compartilhamento com outras
pessoas [24]. Jogos, informacdes, pacotes educativos e
recreativos, t-commerce € servigos utilitdrios, como bancos, lojas
e aplicacdes financeiras sdo outras opgdes. Junto a tudo isso,
provedores preocupados em saber qual contetido é mais relevante
para seus usudrios e a capacidade de armazenar, monitorar, mover
e redistribuir esse contetddo, de forma gratuita ou licenciada. Essas
especificagdes prevéem a procura, selecio, aquisicdo e uso legal
de contetido particular armazenado local e/ou remotamente vindo
por broadcast ou de servigos online (pelo canal de interatividade)
[23]. Dessa forma, o TV-Anytime é atualmente o padrio de
metadados mais completo para TV digital.

5. PROPOSTA DE EXTENSAO PARA OS

PADROES EDUCACIONAIS

O IEEE LOM ¢ a base dos padrdes de metadados utilizados para a
educacdo e, por esse motivo, também foi utilizado como

referéncia neste artigo, uma vez que o principal objetivo € a
aplicac@o da proposta na drea educacional.

Com base no estudo realizado sobre os diversos padrdes de
metadados, o objetivo neste capitulo é descrever algumas
categorias de metadados ainda ndo previstos pelos padroes
educacionais e que, além de importantes devido a inser¢do das
novas midias de TV digital e mdveis, possibilitam a

interoperabilidade dos aplicativos entre as diferentes plataformas.

As secdes a seguir apresentam os dois conjuntos de metadados
propostos como uma extensdo ao padrao LOM, juntamente com a
justificativa do porque cada grupo de metadados foi recomendado.

5.1 Metadados de Adaptacao

Embora a situaciio ideal fosse aquela em que todo contetido ou
midia produzida pudesse ser transmitido e executado exatamente
da mesma forma em qualquer tipo de dispositivo, algumas
caracteristicas especificas de cada um deles impedem que esse
ideal seja alcangado.

Tomando como exemplo um curso educacional em video. Esse
video deverd ser disponibilizado em pelo menos dois formatos
(dois arquivos distintos): um para dispositivos moveis (com
codificacdo H.263) e outro para a Web e TV (com codificagdo
H.264). Embora sejam duas midias, o objeto de aprendizagem € o



mesmo, apenas em formatos diferentes. Dessa forma, ambas as
midias terdo o mesmo titulo, descri¢do, assunto, autor, palavras
chaves, etc, ou seja, sdo referentes ao mesmo objeto de
aprendizagem.

Se essas midias forem vistas como objetos de aprendizagem
distintos, pelo menos dois problemas poderdo ser observados: (a)
o trabalho de geracdo dos metadados do OA serd dobrado, pois
mesmo com todos os dados descritivos sendo iguais, serd
necessdrio documentar repetidas vezes, uma para cada arquivo
fisico de metadados; (b) quando o usudrio procurar pelo assunto
do curso, os dois videos serdo apresentados para o usudrio e o ele
precisard selecionar o video adequado, dependendo do tipo de
dispositivo que estd utilizando.

Uma melhor solug@o € catalogar de forma unificada esse contetido
e quando o usudrio selecionar tal objeto, que o sistema identifique
automaticamente o tipo de dispositivo e envie a midia adequada,
sem que o usudrio necessite saber dessa diferenciacéo.

Essa funcionalidade pode ser atingida por meio de metadados de
adaptacdo, onde apenas os metadados técnicos necessitardo ser
repetidos (mas para cada tipo de dispositivo terd informagdes
diferentes), enquanto os demais dados descritivos (titulo,
descricao, etc) serdo documentados uma unica vez.

Como sugestio para adogd@o junto ao padrio LOM, optou-se por
estender o grupo 4:Technical, incluindo novos metadados. A
seguir serdo descritos resumidamente os principais, e citados os
demais por questdes de espago.

4.8:SupportedPlatforms: indica em quais plataformas o objeto de
aprendizagem estd apto a ser executado. Foram previstos trés tipos
basicos de plataformas digitais para disponibilizacdo de OAs:
Web, TV digital (DTV) e dispositivos méveis (mobile).

4.9:PlatformSpecificFeatures: lIdentifica os dados técnicos das
midias, da mesma forma que o item 4:Technical, porém aplicados
a cada uma das plataformas para as quais o objeto de
aprendizagem foi previsto. Esse novo grupo de metadados é
opcional, caso os metadados técnicos gerais informados valham
para as trés plataformas (metadados 4.1 a 4.7 do LOM), mas pode
ser repetido mais de uma vez, caso o valor de um ou mais
metadados  técnicos sejam  especificos para determinada
plataforma indicada no item 4.8:SupportedPlatforms.

4.9.1:SpecificPlatform: Tipo da plataforma digital a qual se
aplicam os parametros. Utiliza o mesmo vocabuldrio de tipos de
plataforma usado no item 4.8:SupportedPlatforms.

4.9.2:SpecificFormat: Formato da midia criada para utiliza¢cdo na
plataforma especificada no item 4.9./. Segue as mesmas
definicdes e regras do item 4./:Format do LOM, porém aplicadas
a midia especifica.

4.9.3:SpecificSize: Tamanho da midia criada para utilizagdo na
plataforma especificada no item 4.9./. Segue as mesmas
defini¢des e regras do item 4.2:Size do LOM, porém aplicadas a
midia especifica.

4.9.4:SpecificLocation: Uma sequéncia de caracteres utilizada
para acessar a midia criada especificamente para utilizacdo na
plataforma especificada no item 4.9./. Segue as mesmas
defini¢des e regras do item 4.3:Location, porém aplicadas a midia
especifica.

Além desses, também foram definidos e especificados os
seguintes:
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o 4.9.5:SpecificRequirement;

o 4.9.5.1:SpecificOrComposite;

o 4.95.1.1:SpecificType;

e 4.95.1.2:SpecificName;

o 4.9.5.1.3:SpecificMinimumVersion;

o 4.9.5.1.4:SpecificMaximumVersion;

e 4.9.6:SpecificInstallationRemarks;

o 4.9.7:SpecificOtherPlatformRequirements.

Como se pode observar, os nomes adotados para os metadados
4.9.2:SpecificFormat até 4.9.7: SpecificOtherPlatformRequire-
ments seguem a mesma nomenclatura dos itens correspondentes
no LOM, porém precedidos do prefixo “Specific”. O objetivo de
manter nomenclatura similar € facilitar a identificagdo dos campos
correspondentes aos do item 4:Technical geral (ou seja,
independente  da  plataforma) com o grupo 4.9
PlatformSpecificFeatures (dados técnicos especificos para uma
determinada plataforma). O prefixo “Specific” foi utilizado para
ndo haver duplicidade de nomes, conforme recomendag@o do
préprio padrao LOM.

Mesmo com a padronizacido de nomenclatura adotada neste artigo,
observa-se que a proposta é facilmente adaptdvel para estender
outros padroes de metadados ji existentes e que ainda ndo
suportam tais recursos.

5.2 Metadados para Segmentacao

Em arquivos multimidia, por exemplo, nem sempre um usudrio se
interessa por um video por completo. Em algumas situacdes, pode
se interessar por um determinado trecho ou alguns trechos
relacionados a um determinado tema. Por exemplo, em um curso
sobre televisao digital, o usudrio queira ver apenas as partes que
tratam dos aparelhos receptores. Isso pode ser viabilizado por
metadados de segmentagdo.

Um segmento € um fragmento continuo de um programa. Um
segmento particular pode pertencer a um Unico programa, mas
pode ser membro de vérios grupos de segmentos. Um grupo de
segmentos denota uma colecdo de segmentos que sdo associados
por uma finalidade particular ou devido a uma propriedade em
comum. Um grupo de segmentos pode conter segmentos ou outros
grupos de segmentos, de um ou mais programas [23].

O padrio LOM também foi estendido com um novo grupo de
metadados, o [10:SegmentinformationTable, cujos metadados
basicos originaram-se do padrdo TV-Anytime [23], mas de forma
adaptada para atender as necessidades educacionais. Com as
modificacdes, esse conjunto de metadados possibilita segmentar,
além de dudio e video, outros formatos como texto, imagens ou
até itens ndo digitais (como livros ou revistas). A lista de
metadados sugerida como extensdo ao LOM ¢ descrita a seguir:

10:SegmentInformationTable: novo grupo que conterd o conjunto
de informagdes referente a segmentacdo e grupos de segmentos
dos objetos de aprendizagem.

10.1:SegmentList: lista de segmentos de um objeto.

10.1.1:SegmentInformation: Agrupamento das informagdes de um
segmento.

10.1.1.2:Segmentldentifier: Identificador tnico do segmento no
objeto de aprendizagem.



10.1.1.3:SegmentTitle: Titulo do segmento.

10.1.1.4:SegmentDescription:  Descrigdo do  contetido do
segmento.
10.1.1.6:SegmentKeyword:  Palavras-chave  referentes  ao
segmento.

10.1.1.7:SegmentMediaType: Classifica o segmento em document
(conteddo texto, nos formatos txt, doc, odt ou ndo digital),
hyperdocument  (hiperdocumentos no formato HTML ou
XHTML), audio, video ou others (outros).

10.1.1.8:Start: indica o inicio do segmento no objeto de
aprendizagem. Para tipo de midia do segmento document, o inicio
do segmento serd a pagina e, opcionalmente, a linha de inicio. Se
o tipo de midia for hyperdocument, serd o nome de uma péagina,
uma se¢do ou bookmark da pagina, indicado pelo caractere “#”,
ou ainda alguma midia embutida na pédgina (nesse caso, O
segmento € a secdo ou a propria midia referenciada). Se o tipo de
midia for audio ou video, sera informado o tempo em que inicia o
segmento.

10.1.1.9:End: Localiza o final do segmento no objeto de
aprendizagem. Para midias do tipo document, audio ou video,
segue a mesma sintaxe do item /0././.8. Caso ndo seja
especificado, o final do segmento sera o final da midia (digital ou
impressa). Para os objetos do tipo hyperdocument, esse metadado
ndo serd preenchido, pois a se¢do indicada por 10.1.1.8:Start ja
indica por si s6 seu inicio e fim.

Além desses, também foram definidos e especificados os
metadados de agrupamento dos segmentos:

o ]0.2:SegmentGrouplList,
o ]0.2.1:SegmentGrouplnformation;
e [0.2.1.1:1dentifier,

o 10.2.1.2:GroupType: highlights, bookmarks, themeGroup,
preview, activities ou other,

o 10.2.1.3:Title;

e ]0.2.1.4:Description;
e ]0.2.1.5:Keyword,

e ]0.2.1.6:Segments;

e ]0.2.1.6.1:Identifier: Identificador tinico do segmento.

6. IMPLEMENTACOES PARA VALIDAR A
PROPOSTA

Com objetivo de validar a proposta, foram convertidos trés
objetos de aprendizagem para formatos interoperdveis e gerados
arquivos XML com os metadados para os mesmos. O primeiro
objeto € um video e os demais sd3o compostos por paginas Web,
imagens e videos, o que demonstra a flexibilidade da proposta.

6.1 Objeto de Aprendizagem ‘‘De onde vem a

televisao?”
O primeiro objeto de aprendizagem, onde foram aplicados os

metadados de extensdao, é um video chamado “De onde vem a
televisdo?”, originalmente disponivel no repositério SACCA’ em

> http://cesta.cinted.ufrgs.br/sacca/player/dove/dove7.wmv
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formato wmyv. Esse objeto de aprendizagem explica a origem da
televisdo, contando um pouco de sua histdria, além de explicar
como ¢ o funcionamento da transmissdo de TV atualmente.

Esse video foi convertido para o formato H.264/AAC e
encapsulado num arquivo “.mp4” para execug¢do na TV digital e
Web, e para o formato H.263/AAC encapsulado em arquivo
“3gp” para execuc¢do nos dispositivos moveis. Logo, o video é
disponibilizado em dois formatos distintos, que permitem a
execucdo do contetido nos trés ambientes de testes, conforme
ilustrado na Figura 1.

@0 cncevema Vi MockaFreter|| [ L0 s
Arquivo  fditar Egbir Histérico Fayortos Ferramentas .

=2 C & (Oar -G~

Figura 1. Objeto de Aprendizagem “De onde vem a
televisdo?”, apresentado nas trés plataformas.

A Figura 2 ilustra alguns valores de metadados gerados para o
grupo 4:Technical, ja com a extensdo proposta. Como se pode
observar, o metadado SupportedPlatforms indica que este objeto
de aprendizagem esta disponivel para as plataformas mével, Web
e de TV digital. O grupo PlatformSpecificFeatures aparece duas
vezes, uma para moveis e uma para TV digital (indicado pelo
metadado PlatformType). Para a plataforma mével, descreve que
o video possui um formato, localizacdo e requisitos especificos
(indicado pelos metadados SpecificFormat, SpecificLocation e
SpecificOtherPlatformRequirements, respectivamente). Jd para
TV digital, apenas especializa os metadados referentes aos
requisitos  especificos  (SpecificRequirements e  subitens),
indicando que na TV digital necessita do middleware Ginga para
executar esse video, enquanto que na Web serd executado
diretamente de um browser. Uma vez que as demais informacdes,
como formato e localizagio, sdo as mesmas dos metadados gerais
(Format e Location, respectivamente), pode-se omiti-los, pois
herda os valores informados no metadado geral equivalente (o de
mesmo nome, porém sem o prefixo Specific).

<Technical>
<Format>video/mpeg</Format>
<hocation>rtsp://143.54.132.100/dove7 .mp4</Location>
<Requirement>
<orcomposite>
<Type>Browser</Type>
<Name>Mozilla Firefox</Name>
<MinimumVersion>3.0</MinimumVersion>
</OrComposite>
</Requirement>
<OtherPlatformRequirements>Plugin para videos</OtherPlatformRequirements>

:>Mobile</:
>DTVL/ .
>WEBL/

<PlatformSpecificFeatures>
<Pl ile</P1 he>
<SpecificFormat>video/3gp</SpecificFormat>
<specificLocation>rtsp://143.54.132.100/dove7.3gp</SpecificLocation>
<SpecificOtherPlatformRequirements>Real Player</SpecificOtherPlatformRequirements>|
</PlatformspecificFeatures>

<PlatformSpecificFeatures>
<PlatformType>DTV</PlatformType>
<SpecificRequirement>
<SpecificOrComposite>
<specifieType>middlware</SpecificType>
<SpecificName>ginga</SpecificName>
<specificMini ien>1.0</specifi
</specificorComposite>
</specificRequirement>
</PlatformspecificFeatures>
</Technical>

Figura 2. XML dos metadados de extensio ao grupo técnico.



A Figura 3, ilustra a catalogacdo de dois segmentos do video. O
primeiro segmento (que inicia no segundo 46 e finaliza no tempo
2 minutos e 32 segundos) conta a histéria da televisdao, enquanto
que o segundo segmento (que inicia no tempo 3 minutos e 29
segundos e termina nos 3 minutos e 53 segundos) fala sobre as
novidades da TV digital.

<SegmentInformationTable>
<SegmentList>
<SegmentInformation>
Identifier>0001</, Identifier>
<SegmentTitle>Histdria da Televisfo</SegmentTitle>
<SegmentReyword>Televisio</SegmentReyword>
yword>Histéria</, ywerd>
<SegmentMediaType>video</SegmentMediaType>
<Start>PT00HO0M465</Start>
<End>PT00H02M325</End>
</SegmentInformation>
<SegmentInformation>
TIdentifier>0002</; Tdentifier>
<SegmentTitle>Televisfo Digital</SegmentTitle>
<SegmentReyword>Televisio</SegmentReyword>
yword>Digital</. ax
<SegmentMediaType>video</SegmentMediaType>
<Start>PT00H03M295</Start>
<End>PTO0H03M535</End>
</SegmentInformation>
</SegmentList>
</SegmentInformationTable>

Figura 3. XML com dois segmentos do video “De onde vem a
televisao?”.

6.2 Objeto de Aprendizagem “‘Outras

Infancias”

Realizada a validagdo do primeiro objeto de aprendizagem
composto por um video, foi escolhido um segundo objeto de
aprendizagem chamado “Outras Infancias”, desenvolvido pelo
NUTED® (Niicleo de Tecnologia Digital Aplicada 2 Educagdo) da
UFRGS. Esse foi escolhido por utilizar os textos e imagens, e foi
escolhido por ser relativamente simples, sendo um bom estudo de
caso para a validacdo inicial desses formatos de midia, além de ja
ser validado pedagogicamente.

Seguindo as recomendagdes de interoperabilidade propostas,
utilizou-se o formato XHTML para conteido texto, CSS para
adaptar a exibi¢do e JPEG para as imagens. Os arquivos XHTML
permanecem iguais nas trés plataformas. Porém, na TV digital, no
Ginga-NCL Virtual Set-top Box, também foi necessdria a criagdo
de um documento NCL base, pois ele indicard ao player quais
paginas serdo exibidas. O resultado da adaptacdo € a versdo
ilustrada na Figura 4, onde se pode ver fotografias da
implementagdo para Web, TV digital e celulares.

=

Figura 4. Objeto de aprendizagem reformulado e exibido nas
trés plataformas.

Em relacdo aos metadados, conforme ilustrado na Figura 5, o
“Outras Infincias” assim como o objeto anterior € suportado pelas
trés plataformas. Porém, para este objeto de aprendizagem, a
localizagdo € a mesma para as plataformas Web e movel (a
adaptacdo é realizada pelo servidor de aplicagdo e framework
Interop), enquanto que para a TV digital foi disponibilizado um

arquivo diferente, agrupado no formato zip, para ser

8 http://homer.nuted.edu.ufrgs.br/ei2007/infancias/ index.html
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descompactado e executado a partir de um pen drive em qualquer
set-top box que tenha o middleware Ginga.

<Technical>
<Format>XHTML</Format>
<Format>JPEG</Format>
<Location¥>
http://gia.inf.ufrgs.br/OBAT/faces/storags/OutrasTinfancias/index.jsp
</Location>
<Requirement>
<OrComposite>
<Type>Browser</Type>
<Name>MS-Internet Explorer</Names>
</OrComposite>
<OrComposite>
<Type>Browser</Type>
<Name>Mozilla Firefox</Nams>
</orcomposite>
</Requirement>

<SupportedPlatforms>Mobile</SupportedPlatforms>
<SupportedPlatforms>DTV</SupportedPlatforms>
<SupportedFlatforms>WEB</SupportedPlatforms>

<PlatformSpecificFeatures>
<Pl ype>DTV</PL
<Format>ZIP</Format>
<Location>
http://gia.inf.ufrgs.br/OBAI/storage/OutrasInfancias/outrasinfancias tvd.zip
</Tocation>
<SpecificRequirement>
<SpecificorComposite>
<8pecificTypeymiddlware</SpecificType>
i £icName>ginga</SpecificName>
ificMinimumVersion>1.0</SpecificMinimumVersion>
</SpecificorComposite>
</SpecificRequirement>
</PlatformSpecificFeatures>
</Technical>

P!

Figura 5. XML com metadados técnicos do OA.

Em relacdo aos metadados de segmentacdo, aqui é exemplificado
o uso dos metadados de agrupamento (neste caso por assunto),
onde cada segmento é representado por uma pagina XHTML
referente aquele assunto. A Figura 6 ilustra dois segmentos
(paginas i_trab.jsp e i_trab2.jsp) e o agrupamento dessas paginas
(metadados SegmentGroupInformation, Segments e Identifier).
Por questdo de espago, foram descritos e agrupados apenas dois
segmentos, mas podem ser incluidos tantos quantos necessario.

<SegmentInformationTable>
<SegmentTist>
<SegmentInformation>
<SegmentIdentifier>itrab0001</SegmentIdentifier>
<SegmentTitle>Inféncia Trabalhadora — Pagina 1</SegmentTitle>
<SegmentMediaType>XETMI</SegmentMediaType>
<start>
http://gia.inf.ufrgs.br/OBAI/faces/storage/Outrasinfancias/i_trab.jsp
</start>
</SegmentInformation>
<8egmentTnformation>
3 tIdentifier>i 2</! Identifier>
<SegmentTitle>Infincia Trabalhadora - Pagina 2</SegmentTitle>
<SegmentMediaType>XHETMIL</SeqmentMediaType>
<Start>
http://gia.inf.ufrgs.br/OBAL/faces/storage/Cutrasinfancias/i_trab2.jsp
</start>
</SegmentInformation>
</SegmentTist>

<SegmentGrouplList>
<SegmentGroupTnformation>
<Identifier>grp0001</Identifier>
<GroupType /GroupType>
<Title>Inféncia Trabalhadora</Title>
<Segments>
<Identifier>itrab0001</Identifier>
<Identifier>itrab0002</Identifier>
</Segments>
</SegmentGroupInformation>
</SeqmentGrouplist>
</SegmentInformationTable>

Figura 6. Exemplo dos metadados de agrupamento.

6.3 Curso Educacional ‘“Viva Saudavel”

Com o sucesso nas conversdes anteriores, partiu-se para uma
implementagdo do curso educacional “Viva Sauddvel”, cuja
interface ja foi originalmente projetada de forma interoperavel.

Em relagdo a interoperabilidade, utilizaram-se os padrdes
recomendados. Para video, o H.264/AVC, convertido para H.263
encapsulado em 3GP nos celulares. O dudio foi AAC-LC. O texto
utilizou-se do XHTML e CSS, enquanto que as imagens foram
geradas em JPEG.

A Figura 7 ilustra uma pégina de contetido do curso sendo exibida
na Web, no celular Nokia E51 e na televisdo por meio do Ginga-



NCL Virtual Set-top Box. Pode ser observado que hd algumas
leves diferengas no leiaute, principalmente em relacdo a posi¢do
das imagens e tamanho das margens do corpo do indice, além de
diferengas no tamanho e no tipo das fontes.

Figura 7. Exemplo de pagina de contetido do ‘“Viva Saudavel”.

Em rela¢do aos metadados, como a catalogacido € similar a dos
objetos ja apresentados, por se tratar basicamente dos mesmos
tipos de midias e por questdo de espago, os mesmos foram
omitidos neste objeto de aprendizagem.

7. CONSIDERACOES FINAIS

Este estudo apresentou um estudo visando padronizac¢do de midias
e linguagens para obter interoperabilidade entre TV digital, Web e
dispositivos moveis. Efetuou-se um estudo dos padrdes
obrigatdrios em cada plataforma, e gerou-se uma recomendagdo
buscando unificar ao maximo o compartilhamento de midias.
Além disso, identificou ser necessdria uma extensio nos padrdes
de metadados educacionais para contemplar os requisitos de
interoperabilidade e segmentagdo de objetos de aprendizagem.

A extensdo de metadados proposta neste artigo foi adotada como
parte integrante do conjunto de metadados padrdo nacional
OBAA [1], enquanto que as diretrizes para desenvolvimento
interoperavel foram adotadas como recomendagao.

A partir da base apresentada neste trabalho, muitas frentes de
pesquisa se abrem, como a especificagdo de ferramentas de apoio
a geragdo de contetdo interoperdvel, validacdo nos novos
dispositivos que s@o introduzidos no mercado e avaliagdo da
linguagem Java para interoperabilidade, que poderd ser realizada
assim que ambientes de testes forem disponibilizados para o
ambiente de TV digital.

8. REFERENCIAS
[1] OBAA. Portal OBAA. 2011. Disponivel em:
<http://www.portalobaa.org/>. Acesso em: abr. 2011.

W3C. About the World Wide Web Consortium. 2009.
Disponivel em: < http://www.w3.org/Consortium/>. Acesso
em: abr. 2011.

PAULSON, L.D. TV comes to the mobile phone. In IEEE
Computer, April 2006, v. 39, Issue 4, pp 13- 16.

CAGENIUS, T et al. Evolving the TV experience: Anytime,
anywhere, any device. Ericsson Review. no. 03, 2006.

(2]

(31
(4]
[5] LIANG et al. Fusion of digital television, broadband Internet
and mobile communications. In Wiley International Journal

of Satellite Communications and Networking. Vol. 25. Issue
4. p. 409-440. 2007.

CANCORE. Pégina oficial. 2006. Disponivel em
<http://www.cancore.ca/>. Acesso em: out. 2009.

JISC CETIS. Centre for Educational technology &
interoperability standards. 2009. Disponivel em:
<http://jisc.cetis.ac.uk/>. Acesso em: abr. 2010.

(6]

(71

157

[8] PFEIFFER, S.; SRINIVASAN, U. 2000. TV anytime as an
application scenario for MPEG-7. In: Proceedings of the
2000 ACM Workshops on Multimedia. MULTIMEDIA '00.

ACM, New York, NY, 89-92.

DURAND, G.; KAZAI, G.; LALMAS, M. A metadata model
supporting scalable interactive TV services. In: Procedings
of the 11th International Multimedia Modeling Conference
(MMM 2005).

[10] ROESLER, V. et.al. Uma Proposta de Arquitetura
Interoperavel entre Web, TV Digital e Dispositivos Méveis.
In: SBIE 2009. XX Simp6sio Brasileiro de Informatica na
Educagio. Floriandpolis, SC. 2009.

[11] BORDIGNON, A. et.al. Mechanisms for interoperable
content production among Web, Digital TV and Mobiles. In
Proceedings of WCCE 2009: IX IFIP WORLD
CONFERENCE ON COMPUTERS IN EDUCATION. 2009.
Bento Gongalves, Brazil.

[12] VARELLA, F. et.al. Interop: um Framework para o
Desenvolvimento de Contetido Web Interoperdvel entre TV
Digital, Dispositivos Mdveis e Computadores Pessoais. In:
XX Simpésio Brasileiro de Informética na Educacdo - SBIE,
2009, Florian6polis-SC, 2009.

[13] BBC. Designing for interactive television. 2006. Disponivel

em: <www.bbc.co.uk/guidelines/futuremedia/desed/itv/
itv_design_v1_2006.pdf>. Acessado em: abr. 2011.

[14] ABNT NBR 15606-2. Ginga-NCL para receptores fixos e
moveis. 2008. Disponivel em:
<http://www.forumsbtvd.org.br/>. Acesso em: abr. 2011.

[15] W3C. Mobile Web Best Practices 1.0, Basic Guidelines.
W3C Recommendation. 2008. Disponivel em:
<http://www.w3.org/TR/mobile-bp/>. Acesso em: abr. 2011.

[16] IEEE. Standard for Learning Object Metadata. Learning
Technology Standards Committee of the IEEE. 2002.

[17] KUNZE, J. BAKER, T. The Dublin Core Metadata Element
Set: RFC 5013. California: IETF, 2007.

[18] IMS Global Learning Consortium. Pagina oficial. 2011.
Disponivel em: <http://www.imsglobal.org>. Acesso em:
abr. 2011.

[19] ADL. SCORM 2004 4th Edition Version 1.1. 20009.
Disponivel em: < http://www.adlnet.gov/Technologies/
scorm/>. Acesso em: abr. 2011.

[20] ABNT. ABNT NBR 15603-1. Multiplexacdo e servigos de
informac@o (SI). 2008. Disponivel em:
<http://www.forumsbtvd.org.br/>. Acesso em: abr. 2011.

[21] ISO. MPEG-7 Overview (ISO/IEC JTC1/SC29/WG11
N6828). 2004.

[22] ITEC. MPEG-21 Multimedia Framework. Disponivel em:
<http://mpeg-21.itec.uni-klu.ac.at/cocoon/mpeg21/>. Acesso
em: abr. 2011.

[23] TVA. TV-Anytime Forum. 2005. Disponivel em:
<http://www.tv-anytime.org/>. Acesso em: abr. 2011.

[24] LUGMAYR, A.; NIIRANEN, S.; KALLI, S. Digital
Interactive TV and Metadata: Future Broadcast Multimedia.
Springer. 2004.

[9]



